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Notices 

This user manual is intended for administrators and users of the PiXORD P600 Series Network Camera, including 

instructions for using and managing the camera on your network. The use of surveillance devices may be 

prohibited by law in your country. It is the userôs responsibility to ensure that the operation of such devices is legal 

before installing this unit for its intended use. 

 

Before the Network Camera is installed, all the safety and operating instructions should be carefully read and 

followed to avoid damage due to faulty assembly and installation. This also ensures the product is used properly as 

intended. 

 

Heed all warnings 

ü Do not drop or strike this equipment 

Sensitive electronics inside the camera are vulnerable to excessive strike. 

ü Do not install the equipment near any flames or heat sources 

Excessive heat could damage this equipment. 

ü Do not cover cloth or to install this equipment in poorly ventilated places. 

Overheating could damage this equipment. 

ü Do not expose this equipment to rain or moisture. Do not touch the power connection with wet 

hands 

Risk of short circuit, electric shock or fire 

ü Do not damage the power cord or leave it under pressure 

Risk of fire or shock circuit 

ü To reduce the risk of electric shock, do not remove the Cover (or Back). 

No user-serviceable parts inside. Misusage, improper, and negligence could damage this equipment. 

Need to refer servicing to qualified service personnel. 

ü Do not continue to operate if there appears to be fault. 

If the unit ceases to function, contact qualified service personnel for help.   

ü All work related to the installation of this product should be made by qualified service personnel 

or system installers. 

 

Liability 

PiXORD Corporation reserves the right to make corrections, modifications, enhancements, improvements, and 

other changes to its products and services at any time and to discontinue any product or service without notice. 

Customers should obtain the latest relevant information before placing orders and should verify that such 

information is current and complete. All products are sold subject to PiXORD Corporationôs terms and conditions of 

sale supplied at the time of order acknowledgment. 
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PiXORD is not responsible or liable for the resale of its products with statements different from or beyond the 

specification/parameters stated by PiXORD. Customers are responsible for their applications using PiXORD 

products. To minimize the risks associated with customer applications, customers should provide adequate 

operating safeguards. PiXORD is under no obligation to provide any further technical support service or 

product/software alteration beyond PiXORD's representation.  

 

PiXORD products are not authorized for use in safety-critical applications where a failure of the PiXORD product 

would cause severe personal injury or death, unless officers of the parties have executed an agreement specifically 

governing such use. 

 

Reproduction of PiXORD information or datasheets with alteration is an unfair and deceptive business practice. 

PiXORD is not responsible or liable for any such statements.   

 

Every care has been taken of this manual. If there are any inaccuracies or omissions, please inform your local 

office. PiXORD Corporation cannot be held responsible for any typographical or technical errors. PiXORD 

Corporation is not liable or responsible for incidental or damages caused by mishandling.  

 

Trademarks 

All names used in this manual for hardware and software are probably registered trademarks of respective 

companies. PiXORD is a registered trademark of PiXORD Corporation. All rights reserved.  

  

Support 

If you require any technical assistance, please contact your PiXORD reseller. You can connect to the Internet 

PiXORDôs website: www.pixord.com for below information, 

 ̧ Download user documentation and firmware updates at PiXORD Support 

( http://www.pixord.com/support/support.asp) 

 ̧ Find answers to resolved problems in the FAQ database. Or contact our FAE at technical support 

(http://www.pixord.com/contact2.asp) 

http://www.pixord.com/contact2.asp
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Introduction 

PiXORD P600 Series Network Camera delivers superior H.264-AVC performance, state of the art design and 

function. P600 Series is specifically adapted for maximum performance indoor applications, such as commercial, 

banking, government buildings, schools, universities and airports. 

 

H.264-AVC video compression can lower bandwidth and storage requirements without compromising image 

quality; Motion JPEG is supported for increased flexibility, as well as multiple independent video streaming. 

 

P600 Series value-added features include; on-board video motion detection, SD slot for storage recording, and 

two-way audio. P600E, the PoE model, is available with full PoE (IEEE-802.3af) feature that supplies function of 

power to the camera via the network, eliminating the need for power cables, reducing installation costs and 

complexity. Consequently, P600 Series is ñBest in Classò for maximum performance IP video surveillance 

systems, demanding superior image quality, ease of installation, and intelligent video capabilities. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 5 

Installation 

 

1. Hardware Connection 
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2. Software Installation 
 

The following software is necessary for the proper display and use of the P600 from the Web site. The 

software will be available from the Software Package CD. 

 

IP Installer 

The IP Installer is used to locate and configure network cameras and video servers on the LAN. This utility is 

useful for conveniently configuring the network settings of the device, or for finding a device once the network 

settings have been modified. To install the IP Installer, from the Software Package CD UI, select IP installer, 

then follow the on screen instructions. 

 

VLC 

Though not necessary, this can be used for viewing the streaming without a Web browser. 
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3. Network Configuration 

 
IP Installer is a utility that provides an easier, more efficient way to configure the IP address and network 

settings of the devices. It even provides a convenient way to set the network settings for multiple devices 

simultaneously using the batch setting function. Moreover, IP Installer can save the network settings for all 

devices as a backup and restore them when necessary. NOTE: Default mode for P600 is DHCP.  

 

Preparation before IP Assignment 

1. Always consult your network administrator before assigning an IP address to your server in order to avoid 

using a previously assigned IP address. 

2. Ensure the P600 is powered on and correctly connected to the network. 

3. MAC Address: Each device has a unique Ethernet address (MAC address) shown on the label of the device 

as the serial number (S/N) with 12 digits (e.g. 000429-XXXXXX). 

 

4. Although the IP Installer is able to find and configure any P600 on the LAN except those that are behind a 

router, it is a good idea to set the host PC to the same subnet. In order to connect to the Web-based user 

interface of the camera, the host PC must be in the same subnet. For more information about subnets, please 

consult your network administrator. 

 

Using IP Installer to Assign an IP Address to P600 

1. Once IP Installer has been successfully installed on the PC, double click the IP Installer icon on the desktop, 

or select it from Start > Programs > Pixord > Device Search > IP Installer. 

 

2. Click the menu bar Tool > Search Network Device to search the device in the LAN. 

 

*0004290000
B1 
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3. From the list, select the device with the MAC Address that corresponds to the P600 that is to be configured. 

The MAC Address is identical to the unitôs S/N (Serial Number). 

4. Double click the item to open the Property Page for the selected device or click the menu bar View > Property. 

  

 

5. After filling in the properties, click [Set] button to complete the configuration settings in the remote device 

while saving configuration in the PC.  

 

Open the Web-based UI of the selected camera 

1. To access the Web-based UI of the selected unit, run the View > Open Web on the menu bar. 

2. If the device has been configured correctly, the default Web browser will open to the home page of the 

selected device. 

3. If you find your browser is opened and automatically connected to the camera Home Page, it means youôve 

assigned an IP Address to the unit successfully. Now you can close the IP Installer and start using your 
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camera. 

 

Verify and Complete the Installation from Your Browser 

When browsing the Home Page for the first time with the Microsoft Internet Explorer
 TM

, you must temporarily lower 

your security settings to perform a one-time-only installation of the ActiveX component onto your workstation, as 

described below: 

1. From the Tools menu, select [Internet Options] 

2. Click the [Security] tab and then click [Custom Level] button to see your current security settings. 

3. Set the security level to Low and click [OK]. 

4. Type the URL or IP address of your camera into the Address field. 

5. A dialog box will pop up asking if the ActiveX control should be installed. Click [Yes] to start the installation. 

 

 

 

 

 

Once the ActiveX installation is complete, return the security settings to their original value, as noted above. 
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4. Monitor Setting    

 
If you are not able to see the image please make sure monitor settings have been configured. 

1. Right-Click on the desktop. Select ñ Propertiesò 

 

2. Change color quality to highest (32bit). 
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Access to the Camera 

Following the successful installation and IP assignment, P600(E) camera will be able to be accessed. The intention 

of accessing to the camera is most likely for the live video images; there are various configurations as well. P600(E) 

works with most Windows system and Browsers. The most recommended browser is Microsoft Internet Explorer 

(6.0 or above). Other browsers, like Mozilla Firefox, Apple Safari and Netscape Navigator, are 

functionalities/configurations partially supported, while live video can work on those platforms where VLC must be 

installed as the video codec. 

 

Note: With Internet Explorer of the access, the installation of ActiveX control (from Pixord Corporation) is required 

as described in the previous section. 

 

Web browser access 

1. Launch a web browser,  

2. Enter the IP address of the camera in the address field of the browser, 

 

3. The login process will require username and password for a new session connection. The default 

username/password is admin/admin. 
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4. After authorized, the web will be directed to the main page of the camera with the live video. 

 

 

Access restriction 

The login account can be divided in 3 groups, which are managed in different levels of access. Anonymous login is 

possible for live video access only. Detail User Account settings can be referenced in the System Options -> User. 

 

 

 

The default account (admin/admin) comes with administrator authentication, which is able to configure all settings. 

It is recommended to change the administratorôs password after login, and/or create more accounts as planned.  

 

The Live View Page 

The first view of logging into the camera web is the live video images with information including camera IP address, 

video format / resolution / frame rate / bit rate and system date.  
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The Quick Function Buttons come with the video panel for immediate functions or taking effect.  

 

 Full screen: enlarge the video image to the current screen size. 

 Listen: the audio sent from camera 

 Talk: the audio sent to camera 

 Record: record current live video images in ñ.aviò format 

 Snapshot: Capture a still live image in JPEG format 

 

 

Further configurations and options; a prominent button in between is used to expand the further operations. Not all 

buttons of function are described below. Options appear when specified in the configuration page. 
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SETUP: Further configurations and functions  

LANGUAGE: Language selection for the Web Interface. 

IMAGE SETUP: An actual size check box. Default is unselected, which Image frame is scaled down or enlarged to 

fit the web VGA size.  

MANUAL TRIGGER: Applied as one of the trigger conditions, see Event Handling for detail.  

VIDEO STREAM: Select the current displayed stream. 
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Video and Image Configuration  

This section describes how to configure the video streaming from the device, and the related camera image 

configurations. Users with Administrator or Operator (see Users Settings) authority are intended for these 

configurations.  

 

Click on  button to enter in the configuration pages.  

 

Video 

There are 3 tabs,  

-  General 

-  Advanced 

-  External Video Source 
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General 

 

 

Video General Setting 

The list of video streams is provided for enable/disable selection. Stream1 is default enabled (selected). Maximum 

3 streams can be concurrently enabled for different client requests. 

 

Digital PTZ: This function is available in stream2. 

 

OSD Setting 

Enable the On Screen Display (OSD) information. A line of text message (e.g. Camera Name or Position) and the 

date/time string are available to be selected for displaying or hiding on the images.  
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Advanced 

The Video Advanced setting page provides more detail stream configurations. These settings can affect video 

size, quality. The expected transferring performance must be under the condition of full network bandwidth  

 

 

 

RTSP Path -  

The RTSP Path is the stream ID used for RTSP client streaming connection, such as VLC player. The default 

values are v00, v01 and v02 for the three streams respectively. The string can be any combination of number or 

capital/small letters. It can not be empty however. 

 

Resolution -  

The resolution here describes an image size counted by width and height, e.g. 640x480, referring to pixel 

resolution. The 1
st
 stream can be set from more options of resolution; 1600x1200 (2 megapixels), 1280x720(HD), 

800x600(SVGA), 640x480(VGA), 320x240(QVGA). While Stream2 has the options of VGA and QVGA, stream3 is 

in a fixed resolution, the QVGA. 

 

Video Mode -  

This option allows the selection of two bit rate modes, the Constant Bit Rate (CBR) or Variable Bit Rate (VBR). CBR 

refers to the setting of a fixed Target Bit Rate (configuration in the rage of 64Kbps to 6Mbps) that would apply in 

the case of limited bandwidth or/and storage requirement. While CBR concerns a fixed data rate transmitting, the 

video quality is of high priority for VBR mode selected. VBR therefore is configured with the Quality Level 

(Standard, Good, Best). In general, CBR predicts the provided condition; if image activity requires higher bit rates 

than configured, the frame rate and quality would be affected as not likely to increase bandwidth (bit rate). In spite 

of the required recording storage estimation, VBR is by way of compensation that adjustable bit rate fits the actual 

image activity.   
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Image Format -  

H.264 and MJPEG are available for image format selection. The term, ñimage formatò, is referring to compression / 

encoding technique. The selection of image format decides the performance of bandwidth and storage requirement. 

In the request of same video quality, H.264 contributes to less bandwidth and storage requirement, which is more 

efficient than MJPEG. 

 

GOP -  

In MPEG4/H.264 video coding, GOP (group of pictures) describes how the different types of frames are arranged. 

The frame types implemented here are I-frame (full image information) and P-frame (motion-compensated 

difference information). This setting configures the GOP length which is the number of frames before next I-frame 

appears. Having more I-frames usually increases the stream size, and therefore more bandwidth and storage are 

required.  

 

Frame Rates -  

The Frame Rates defines the number of frames that will be displayed per second. The frame rate setting can affect 

the target bit rate (bandwidth requirement) and storage requirement. 

 

Note: 

While multiple streaming is possible, each stream has its limitation and dependency to other stream. See ñVideo 

Stream Specificationò.  
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External Video Source 

 

 

 

This page is provided to configure and keep other video links (from specified Pixord video models) that will be 

applied in the web access of the current camera unit, for instance, the application of video conference.  

 

To add an external video link, click ñAddéò to show the configurations. The ñProduct Type:ò lists the models that 

are applicable in this function. While the proper configuration is done, click ñConnectò to test the existence of 

destination server and preview the images. 
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Video Conference 

When ñExternal Video Sourceò is configured with at least one link, the video conference button  can be found 

on the live view page.  

 

 

Press the button, the Video Conference will then be presented as below; the local video is showing left hand side, 

while right panel is displaying remote site video images.  

 

 

 

 



 

 21 

Camera 

This page provides the basic image color appearance and further image settings.  

 

 

 

General 

Brightness: the luminance of image view 

Hue: refer to pure a pure color, or described by its name, such as red, green or blue. 

Saturation: intensity of a specific color  

The 3 correlates are referring image appearance in terms of color/vision. These are adjustable from this page. 

 

Rotation: rotate the image, so it looks up-side down. This can be applied when camera unit must be ceiling 

mounted and the image is therefore reversed.  

Audio: enable this option, so the video stream will be transferring accompanied with the audio data. 

Web Record / Snapshot: define the location where snapshot images and video clips will be stored. The file name is 

referring to the prefix of the actual file name of each snapshot image or video clip generated.  
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Advanced 

White balance: the adjustment to compensate for different environments in terms of light source. 

Exposure: Anti-flicker setting for image sensor to fit the frequency of light (power) source. For instance, the power 

frequency is 50Hz for most European countries, while 60Hz is typically for US. This setting is therefore regionally 

different. Note: Default setting is 50Hz 

Max. Exposure Time: referring to the shutter speed.  

Max. Gain Control: the amplification factor for the incoming light.  

Infrared (IR) Cut Filter: the default is automatically switched according to light intensity. Normally, with plenty of light 

sources (or sun light), there can be infrared included. The filter is automatically switched ñONò, to avoid the image 

sensor from receiving the IR signal.  

Color/Mono Mode: the default is automatically switched according to light intensity. It can also be forced to display 

color image even in a low light environment.  

Video External Output Format: the format of composite output, NTSC/PAL.  
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Event Handling 

Event Handling describes the configurations of event type and the corresponding actions. To have an insight into 

this function, a common example can be storing a captured image to a local storage or remote FTP server 

(Actions), when there is a Motion Event (Trigger Condition). 

 

 

 

Event Server 

 

The ñEvent Server Listò lists the configured server(s) that will act as a remote storage or a destination for handling 

the triggered event. Currently, FTP is the only available server type. Up to 10 FTP servers can be added in the list. 
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Motion Detection 

A snapshot image shows the whole view of the camera covered. To select a motion detection area, click directly on 

the image, then change the size and position by dragging and drawing. Up to 10 motion areas (configurations) can 

be added in the list. Each detection area can be set with its own sensitivity value.  

 

 

I/O Ports 

This model supports 2 photo-coupled relay inputs and 1 relay outputs, see ñI/O Terminal Connectorsò for detail pin 

description and application. The tab shows the status of them; with external trigger/alarm devices.  
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Event Configuration 

The Event Configuration is to assign the actions responding to the specified events (Trigger Conditions). 

 

 

The table lists the configured events. Click on ñAddéò or choose an event from the list to expend the panel for 

detail configurations. ñRemoveò is to delete a selected event. 
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Trigger types (conditions) 

Motion Detection: The configured detection area(s) for motion events.  

GPIN: the physically connected external trigger/button.  

Manual Trigger: a virtual trigger button embedded on the web main page.  

 

When triggeredò Actions 

Store image to FTP (Remote) / SD Storage (Local) 

Activate Relay Output 

Send Email Notification 

TCP Message Notification ï only for GPIN as the trigger condition 

 

Event Schedule 

Events may come frequently, for instance, a moving object keeps triggering as being in a detection area. False 

alarms can therefore occur. The ñminimum time between triggersò setting is then for this case. System waits for 

the given time before the next trigger taken. 

 

By default, each configured event is always effective. It can also be scheduled by selecting start day/time and the 

duration of effective. 
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Local Storage and Schedule Recording 

P600 series model is equipped with a card slot for SD/SDHC storage. This storage is applied for local video 

recording. The recording function can be launched according to schedule. The SD card also records the JPEG 

images responding to an event.  

 

 

 

General 

Define the day (specified by days of a week) and time (specified by each single hour) for that will be recording 

during the scheduled period. User can select which video stream should be recorded, and the size of each sliced 

file. When the check box is ticked, recording process starts at the scheduled hours (red blocks). 

 

 

 

Storage 

Display the storage information, includes disk size info, type and status. The warning message (red text) shows 

when recording is on process; SD card should not be removed during the recording process. 
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The ñBrowseò button allows viewing the list of recorded files. The web page will then be redirect to the root path of 

the SD storage (if one is inserted). The list includes couple of folders, the Oevent_images which contains all the 

still images captured by any event trigger, and folders specified by date where the recorded video files are 

located.  

 

 

The recorded files are named in date_time format, and the extension file name is ñ.h264ò. While file is in h264 raw 

format, it can be played in VLC player. Note that the recorded file includes video only; no audio information is 

recorded.  

 

 



 

 29 

Network Configurations 

The P600 series IP Camera acts as one of the network devices. It is therefore allowed ñIPò to be assigned, so 

certain network functionalities can be implementable within this device. This section describes these configurations. 

Fundamentally, for instance, the IP assignment of the device can be done via DHCP server, manually fixed IP 

option or PPPoE to obtain IP from service provider.  

 

 

General 

Device IP configuration, includes DHCP, Static IP setting and PPPoE. ñEnable ARP/Pingò enable device to accept 

ARP or ping packets from the network. Disable this option may provide extra security from intentional ping. 
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Advanced 

 

 

Enable or configure other network functions. 

 

NTP: Configure a NTP (Network Time Protocol) server, so that the device system date and time can be 

synchronized with a specified Time Server. This configuration is provided for one of the potions of system date/time 

adjustment. 

HTTP: set the HTTP port that will be applied for Web UI access.  

RTSP: set the RTSP (Video) port for video data transmission. 

HTTPS: Enable/Disable Http security function.  

Bonjour: Enable Bonjour service, so that the device can be discovered with ñBonjourò service applied.  

UPnP: Enable UPnP, so that the device can be discovered in an UPnP Compliant Network.  

NAT Traversal: Enable NAT traversal, so that client from Internet can have access to the devices behind the 

Router.  

Note: with UPnP enabled, the IP Sharing device (Router) capable of UPnP function will automatically be noticed 

with the deviceôs NAT port.  
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SMTP(E-Mail) 

Configure an email host in the device that will send email on behalf of the configured email account in a 

circumstance like sending an email notice to a specified mail address (Event Configuration).  

 

Sender: Complete the Mail Server, Server Port, Authentication information (if required) and the senderôs email 

address. 

Receiver: The receiver email address  

 

 

 

DDNS 

Dynamic DNS configuration; the network device can be assigned and accessed with a host name instead of IP 

address by registering this service (Internet access required).  

 

Host Name: Assigned name that will be used for access to the device  

User Name/Password: Account authentication for logging to this service 

Update Time: Periodically, the device updates its access info to sever in the configured time.  

Response: the device responds the connection info.  
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Apply DynDNS 

 

 

 

P600 series network device support DynDNS (www.dyndns.org). This section describes how to apply this service 

to the network camera.  

 

 

 

 

 

 

 

 

 

 

 

 

http://www.dyndns.org/
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Create Account 

 

 

Input user name, password and Email that will be created as an account for logging in the service. . 

 

 

The website has accepted the new account and sent email for verification. 
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In the received mail from DynDNS, use the link to activate. The account will then be confirmed as the web below 

shows.  
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Login and use the service 

 

 

In the login filed, input username and password as the new account created.  

 

 

After logged in, in the ñMy Servicesò column, click on ñAdd Host Servicesò.  
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Fill in a host name as it will be applied to the device. The ñIP Addressò field can be temporally filled with any IP as it 

will be updated once the device has registered to the service and reported its current IP value. Click on ñAdd To 

Cartò for next stage.  
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The Dynamic DNS host service is free. Just click on ñNextò. 

 

 

Checkout from the applying service and active the added host name.  
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The information of activated host name will be arranged as above. Click on ñAdd New Hostò if requiring more host 

names for other network cameras.  

 

 

Apply Host Name to the Camera 

 

 

In the device configuration page, Setup -> Network -> DDNS, fill in the applied host name from DynDNS website, 

the username / password that are for logging in this service. Enable DDNS then save the settings. The ñResponseò 

will show ñyesò message when registering is successful.  
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Launch IE and type http://p600.gotdns.com (for instance) in the URL filed. The page should be directed to the 

deviceôs live view page.  

 

 

 

 

http://p600.gotdns.com/
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System Options 

 

 

 

Information 

Lists of System and Network configurations 
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User 

Login users for Web access and operations; authentication required. The Check box is for anonymous logging on 

to the live view page. Logging for further configurations will still require user name and password.  

 

 

 

 

 



 

 42 

Date & Time 

System date/time configuration. Options of synchronizing with PC and NTP server are provided for automatic 

adjustment.  
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Server Maintenance 

This page provides tools for system maintenance; Reboot and Load default settings, as well as functionalities of 

launching upgrade process, backup/restore user settings and language defines.  
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Log Service 

Most system operations and / or process will be kept in a log system. The link provides the review of these records.  
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Web Interface Customization 

This page provides the function of adjusting the look of live view page. There are two types of layout settings; use 

default look or use custom settings.  

 

 

 

Use Default Look: the default layout of live/configuration pages 

Use Defined Links: Web link(s) will be presented on the live page when enabled. It can be a link to another IP 

camera for instance, or other preferred web link. 
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Use Custom Settings: The modifications allowed are change of Background / Text Color, Background picture, Title, 

Description, Logo and etc. 
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Connectors 

View of Back panel 

 

 

 

DC-Iris 

For replacement of lens that comes with auto iris (DC-Iris), this connector provides power to electronically control 

the iris. In this case, the amount of light going through the lens then camera inside is automatically regulated. 
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Composite Video Output 

The composite video signal is retrievable from this connector. It is BNC (Bayonet Neill-Concelman) type as the end 

of both camera and terminal device, like TV Monitor or Recorder, with coaxial cable linked in between.  

 

 

Audio Out 

The 3.5mm audio stereo jack is for audio output that comes from a client PC. See ñTalkò in ñThe Live View Pageò.  
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SD Card Slot 

This connector allows SD type (includes SDHC) storage to be inserted in. The table below lists the SD/SDHC cards 

that have been approved compatible for this IP Camera device. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Manufacturer Type Capacity 

Apacer 
SDHC 8GB 

SD 2GB 

Transcend 
SDHC 8GB 

SD 2GB 

SanDisk 
SDHC 8GB 

SD 2GB 
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I/O Terminal Connector - Pin Assignment 

 

 

Pin Function Description 

1 COM Digital output implementation; Pin2 to COM (Pin1) is a Photo-coupled relay on 

Normal Open status. External device can directly connect to the terminals. 

However the current that will go through the 2 nodes must not exceed 130mA. An 

external ñRelayò can also be connected to the terminals as an implementation. In 

this case, current (or/and voltage) limitation is specified by the external Relay.  

2 Relay-No 

3 GND Two sets of Digital Input, DI1 and DI2; the internal device is also photo-coupled 

electrical relay. In practice, the external device can be simply an On/Off switch. 

Two sets of On/Off switch can be connected as different trigger source. 

4 DI1 

5 DI2 

6 12V An extra power entry for the camera device; or if power is supplied from the DC 

jack, Pin6 can provide 12V power output. This power can be supplied for the 

external ñRelayò device. The Pin7 is the same ground as Pin3.  

7 GND 
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Troubleshooting 

Check firmware version 

The version code can be found in Setup -> System -> Information, or simply type ñversion.htmlò after the URL 

address, e.g. http://192.168.0.200/version.html. Firmware version indicates the functionalitiesô updates or 

availability in the camera system. Therefore, in the first step of troubleshooting and then reporting, it helps to locate 

the found issues. Newer version firmware may have corrected the current bugs.  

 

 

 

 

 

http://192.168.0.200/version.html
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Upgrade device firmware 

Firmware upgrade process should be done via the web configuration; Setup -> Server Maintenance -> Firmware 

Upgrade. Before the process, read the instructions and release notes coming with each new released version. For 

the steps,  

1. Check and retrieve the latest firmware bin file. 

2. Disconnect all clients (e.g. streaming requests) to the device that will be firmware upgrading. 

3. Stop the local (schedule) recording if it was enabled. 

4. Go to the Firmware Upgrade page, browse and locate the downloaded firmware bin file, then click on 

ñUpgradeò button. 

 

 

5. The upgrade should start in minutes, depending on file transferring status. The web will then be directed to 

the system writing progress. Overall upgrading process takes about 5~10 minutes. In this period, DO NOT 

DISCONECT the power. System of the unit can be damaged otherwise.  

 

6. The power LED (orange one) will be quick/slow flashing during the upgrading process. When it becomes 

again steady on, camera is ready to be accessed. Check the firmware version. If somehow system is not 

upgraded, redo above steps. In the case, restore factory default process may be required. 

 



 

 54 

Restore Factory Default Settings 

In some cases, system does not respond to any operation, this process gets the unit back to initial status, so that it 

can be reconfigurable for up and running again.  

 

 
 

To restore factory default, follow the steps below: 

 

1. Unplug the power jack to turn off the camera 

2. Insert a pin into the reset hole Sense a button and keep it pressed until instructed to release. 

3. Plug in the power jack to turn on the camera. The power LED will start flashing in a short while.  

4. Release the pin when the LED starts quick flashing. The device should be set back to factory default. 
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Technical Specifications 

Product Specifications 

Video Compression H.264 / Motion JPEG 

Video Resolution 

UXGA: 1600x1200  

HD720: 1280 x 720  

SVGA: 800 x 600 

VGA: 640 x 480 

QVGA: 320 x 240 

Bit Rate 64K ~ 6M bits/sec (CBR/VBR configurable) 

Frame Rate 
30 FPS @ HD720/ SVGA/ VGA/ QVGA,  

15 FPS @ UXGA at both H.264/ MJPEG resolutions 

Image Device 1/3ò 2 Megapixels Progressive Scan CMOS Sensor 

Lens Type 
Fixed Lens, CS Mount , IR correction, Focal Length 6.0mm, 

F2.4 

IR Cut Filter Removable IR Cut Filter 

Minimum Illumination 1.5 Lux @ F2.0 

Video Control 

Multi-Stream H.264 and Motion JPEG, controllable frame/ 

bitrate(bandwidth),VBR / CBR control , RTSP Path, Digital PTZ 

to choose image area 

Image Adjustment 
Brightness, Saturation, Sharpness, Exposure control , White 

balance, Backlight compensation, Rotation 

Event System 

Trigger GPIN, Motion detection, Manual Trigger 

Action 

File upload via FTP, E-Mail and SD storage 

Alarm Notification via E-Mail 

External output activation 

Video buffer Pre and post alarm (F/W to be upgrade) 
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Local Storage SD/SDHC card 

Network Interface 10BASE-T/100 BASE-TX 

Protocols 
HTTP,HTTPS, TCP/ IP,IPv4, UDP, SMTP, FTP, DHCP, DDNS, 

NTP, DNS, ARP,RTSP, RTP, Bonjour, UPnP 

Audio Capability 1 x Built-in Microphone, 1 x Audio output 

Audio Compression u-Law PCM 8Khz 

Power Supply 

AC/DC switching power adapter, input: AC100 ~240V, output: 

DC 12V/2A 

Built-in PoE IEEE 802.3af Class 3 (for P600E model only) 

Security Password Protection , Https encryption , User access log 

Power Consumption 5W 

Operation Temperature 0
o
C ~ 50

o
C 

Operation Humidity 20% ~ 80% RHG 

Dimension (L x W x H) 85mm(W)x78mm(L)x70mm(H) 

Net Weight  Camera only 370g/ Camera with Stand 510g 

Operation Platform Microsoft Windows 2000 / XP/ Vista 

Browser    IE 6.0 above 

Certification Report CE/FCC, ROHS,WEEE 

I/O Connectors 

1x DC IRIS connector 

1x RJ45 10BASE-T/100 BASE-TX 

1x Default setting button 

1x SD card socket 

1x BNC composite video output 

1x DC jack (12V)  

1x Terminal blocks (Alternative power,12V/GND, Digital input 

x2, GND, Digital output)  

1x Audio line out,3.5mm 
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Package Contents 

1 x CD (manual and software) 

1 x QIG  

1 x Terminal block  

1 x Stand for mount 

1 x AC/DC Power Adapter (Not included for P600E model) 
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Video Streams Specification 

The availabilities 

1. Each stream can be switched to either H.264 or MJPEG mode. 

2. Each steam can be configured to either CBR or VBR mode. 

3. Stream1 (main stream) is available from all the resolutions listed. 

4. The maximum resolution setting for Stream2 is 640x480. 

5. Stream3 is fixed in 320x240. 

6. The maximum frame rate for transferring 1600x1200 is 15fps. Others can reach up to 30fps. 

  STREAM1 STREAM2 STREAM3 

Encoding Mode       

H.264 / MJPEG V V V 

Transferring Mode       

CBR / VBR V V V 

Resolution @ Max. FPS       

1600x1200@15 V     

1280x720@30 V     

800x600@30 V     

640x480@30 V V   

320x240@30 V V  V 

 

Dependency 

1. Max. FPS dependency: when Stream1 is set to 1600x1200, the maximum frame rate is 15fps. Accordingly, 

both Stream2 and Steram3 can be configured with the frame rate from 5 to 15 fps. 

2. Resolution dependency: The maximum resolution of Stream2 is depending on the resolution setting of 

Stream1. When Stream1 is set to 320x240, Stream 2 is limited in 320x240. 

3. Frame rate independent: Frame rate setting for each stream can be independent, for instance, Stream2 can 

be set 15fps and Stream3 is 30fps while Stream1 (1280x720 or below) is set to 5fps. 

 

STREAM1 
STREAM2 STREAM3 

640x480 320x240 320x240 (fixed) 

1600x1200, 5~15 fps 5~15 fps 5~15 fps 

1280x720, 5~30 fps 

5~30 fps 
5~30 fps 

800x600, 5~30 fps 

640x480, 5~30 fps 

320x240, 5~30 fps   5~30 fps 

Note the resolution setting must follow the sequence: Stream1 ʿ Stream2 ʿ Stream3.  

 

 

mailto:1600x1200@15
mailto:1280x720@30
mailto:800x600@30
mailto:640x480@30
mailto:320x240@30
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The Angle of View 

The setting of Stream1 determines the angle of view, therefore the range of image view. The pictures below present 

the 3 ranges of view, 1600x1200, 1280x720 and 960x720* (is not existed/selectable resolution), and the actual 

view of each resolution. The resolutions, 800x600, 640x480, 320x240, will be the scaling down from actual view 

angle. 

 

 

      

 

Actual View Angles 

Scaled Resolutions �± from 1600x1200 Scaled Resolutions �± from 960x720, when 

Stream1 is equal to or below 1280x720 


